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Introduction 
Network facilities are becoming increasingly crucial in the present day IT environment. Traditionally communication 
used to be established between individual hosts, i.e. sender (or source) and receiver. However, such recent phenomena 
as IP video conferencing, streaming media, etc. gave rise to a real problem of efficient one-to-many communication 
means. Just imagine how much network traffic would be needed to conduct an IP video conferencing among a dozen of 
participants. Actually the current Internet technology simply cannot keep up. That is where Multicast comes into scene. 
It is a specially developed technique providing data delivery from one location to many others without any unnecessary 
packet duplication, thus minimizing server load whereas maximizing the network performance. With that technique 
only one packet is sent from a source and is replicated as needed in the network to reach as many end users as 
necessary. Obvious benefits it offers may also be successfully applied to the problem of the system deployment 
technological chain. 

Paragon Deployment Manager™ is a powerful multifunctional solution for system deployment, recovery and cloning. 
Besides possibility to make complete, reliable backups of the system and critical data, it enables, by employing state-of-
the-art network technologies, to automatically deploy practically unlimited number of computers at a time as easy and 
quickly as never before.  

Paragon Deployment Manager provides a user-friendly interface with highly customizable automation and an abundant 
set of post imaging configuration options, i.e. everything to make a job of a system administrator as easy and 
convenient as possible. Moreover, minimum efforts are required for integration with Microsoft® Sysprep for a complete 
out of the box experience. 

With our solution you will dramatically reduce deployment time, resource requirements and costs. The key features of 
the program are listed in the special chapter. 

Setting up any operation is accomplished by using practical wizards. Each step of the wizard includes in-depth 
information in order to allow you to make the right choice. Graphical representations of the data help you to gain a 
better understanding. 

In this manual you will find the answers to many of the technical questions which might arise while using the program. 

 

Our company is constantly releasing new versions and updates to its software, that's why 
images shown in this manual may be different from what you see on your screen. 
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Key Features 
Let us list some of the key features:  

• User friendly interface. Easily understood icons accompany all functions of the program. 

• Comprehensive wizards simplify even the most complex operations. 

• Fast and powerful system imaging and hard disk partitioning with Paragon Hard Disk Manager™. 

• Support of deployment templates to minimize the system deployment time and costs. 

• Use of Post-Config options enables to easily customize the client disk layout and set up the required Windows 
settings (PC name, DNS, display, etc.). 

• Ready-made Post-Config templates to accomplish the most frequently used operations after deployment. 

• Adaptive Restore template to successfully recover Windows 2000/XP/Server 2003 as well as Windows 
Vista/Server 2008 to a different hardware configuration. 

• PXE Server support to remotely boot client computers. 

• Server-driving mode provides simultaneous deployment of one image to many computers. 

• Client-driving mode to launch the deployment procedure from the client’s side, thus bypassing the central 
console management. When using one and the same image you can take all advantages of simultaneous 
deployment as well. 

• Automatic multisession cyclic deployment for manufacturing purposes. 

• Simple Restore configuration to deploy directly from the bootable media. 

• The system of advanced log facilities (session logs, history logs, current activity logs, etc.) assists you to monitor 
real-time every action of the program in order to get in-depth information on the deployment procedure. 
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Installation and Package Contents 
This chapter provides information that is needed to perform the correct installation of the program, and in addition, 
checks if the current installation is working correctly. 

There can be situations when it is required to deploy the client computer(s) but no network support is available at the 
moment. Especially for that purpose the Boot Media Builder™ already contains the Simple Restore configuration to 
deploy directly from the bootable media. 

Package Contents  
Deployment Server: 

The installation package for the Deployment Server includes the following components:  

• Hard Disk Manager to create/restore backup images or carry out partitioning operations, etc 

• PXE Server (includes DHCP and TFTP services) to remotely boot client computers 

• Infrastructure Server to initiate and control the deployment procedure 

• Deployment Console™ to set up and manage remote computers 

• Boot Media Builder to prepare client bootable media 

Target Module: 

The Target Module also contains several components. It does not require installation: 

• Server-driving/Client-driving mode to make remote computers be recognized in the network as targets for 
deployment purposes 

• Hard Disk Manager to create/restore backup images or carry out partitioning operations, etc 

• Simple Restore Wizard™ to easily get the system back on track again 

• Log Saver to tackle problems with handling the program by compressing logs to send to the Paragon Support 
Team 

 

With the help of the Boot Media Builder it is also possible to create a custom item to set for 
execution some Paragon script or any other program. 

Minimum System Requirements 
To use the program on a computer satisfactorily, ensure that it meets the following minimum system requirements:  

Deployment Server: 

• Operating systems: Windows 2000/XP/Server 2003/Vista/7/Server 2008 and XP/Server 2003/Vista/7/Server 
2008 64-bit 

• Network Interface Card (NIC): 100 Mbps and higher 

• Open ports in Firewall for TCP/UDP: from 2017 to N, where N depends on max number of sessions in progress, 
working simultaneouslyPXE support 

• Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed 

• 256 MB of RAM 
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• SVGA video adapter and monitor  

• Mouse (recommended) 

Target Module: 

• Network Interface Card (NIC): 100 Mbps and higher 

• PXE-enabled NIC (recommended) 

• Wake-up on LAN support (recommended) 

• Intel Pentium CPU or its equivalent, with 300 MHz processor clock speed  

• 128 MB of RAM for the Linux and 512 MB for the WinPE target module 

Installation Procedure 
Since the Target Module does not require installation, this operation can only be applied to the Deployment Server. The 
installation package contains several components, some of which are independent (PXE Server, Infrastructure 
Serve , r Deployment Console), i.e. they can be installed separately on different computers. 

 

To optimize the network performance it is strongly recommended to install the 
Infrastructure Server on a File Server where master images are kept. 

The installation process consists of the following steps: 

1. Run Setup Application. From the folder, where the setup files are kept, run the Deployment Manager.MSI file. 
This application will guide you through the process of the program installation. The setup utility is compiled 
with the InstallShield SDK, hence it contains the standard user interface and set of installation steps. 

 

In case there is some previous version of the program installed on the computer, the 
program will offer you to uninstall it first. 

2. Starting Setup. The Welcome page informs that the application is being installed. Click the Next button to 
continue. 

3. Select Components to Install and an Installation Folder. The next page enables you to select what components 
are to be installed and also set an installation folder: 
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Call the popup menu for the required item (left click of the mouse button on the icon), then select whether to 
install the component or not. A brief description to the selected feature and approximate disk space needed to 
install it will be displayed on the right, thus precluding any mistake being made on your part. 

 

To know more on how to select particular components to install, please click the Help 
button. 

Choose a folder where the program will be installed. By default, the installation folder will be created as: 

C:\Program Files\Paragon Software\Deployment Manager. To select another folder, click the Change… button. 

 
Click the Space button to get information on available space of all disks in the system. 

4. Set PXE Server (in case it’s been selected to install). According to the current LAN configuration there are 
different work algorithms to set up the PXE Server: 

o In case an active MS DHCP server is found on a local PC, the program will offer you to choose whether to 
configure it automatically right now or manually later: 

 

It is recommended to choose the automatic configuration. Then options 066 and 067 of the MS DHCP server 
will be automatically set up to work with our TFTP server. And after the product de-installation the original 
state will be restored. 
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If you choose the manual configuration, you’ll have to configure the MS DHCP server manually after the 
installation is completed. 

o In case no MS DHCP server has been found on a local PC, the program will ask you whether to install our 
DHCP server or not: 

 
 

Click the Yes button if there is no DHCP server at all, thus the program will install and configure both DHCP 
and TFTP servers. Click the No button if there is an active DHCP server, in that case the program will only 
install the TFTP server, and then configure the current DHCP server to work with it. 

To make the PXE Server work properly you should define DHCP parameters for the PXE Server: 

 

 

It is not recommended to install the Paragon PXE Server when there is already an 
active DHCP server in the LAN. 

5. Set path to the Image Storage (in case the Infrastructure Server has been selected to install). The Set Path to 
the Image Storage page offers you to define a default location of backup images:  

 
 

 

To avoid any problems with mounting network shares the name should contain no more 
than 12 symbols. 

6. Set Infrastructure Server (in case it’s not been selected to install). On this page you should define a name or IP 
address of the computer with Infrastructure Server installed: 

 
7. Verify Setup Settings. The Ready to Install the Program page informs you that everything is ready to install the 

program. Press the Back button to return to any of the previous pages and modify the installation settings. Click 
the Install button to complete the installation process. 



11 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

8. Copying Files. The Copying Files page shows the overall progress of the installation. Click the Cancel button to 
abort the setup. 

9. Finishing the Installation. The Final page reports the end of the setup process. Click the Finish button to 
complete the wizard. 

 

All components of the package except Hard Disk Manager are ready to launch immediately 
after completing the installation process. Hard Disk Manager uses a kernel mode hotcore 
driver that is why the system reboot is required to complete its setup. 
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Basic Concepts 
This chapter explains terms and ideas that show how the program works. To understand these helps to obtain a general 
notion of the operation performance and makes it easier for you to operate the program. 

Multicast versus Broadcast and Unicast in the Framework of System Deployment 
In the course of time there have been developed three principal techniques as far as transmission of data on the 
network is concerned, i.e. Unicast, Broadcast and the cutting edge Multicast. Offering diverse work concept, all the 
three are used for accomplishing specific tasks. Let us just see how these transmission techniques can be applied to the 
system deployment issue. 

In general system deployment involves simultaneous deployment of multiple computers for the manufacturing 
purposes. As for the network capacities this procedure is realized as transmission of some standardized backup images 
from the Server to multiple Target computers. Thus the most suitable data transmission technique is to offer the 
following relevant characteristics: 

• Simultaneous transmission of one image to many computers without any redundant packet duplication 

• The least possible Server work-load 

• Open scalability 

To get a better notion of the problem, let us just scrutinize the three transmission techniques a bit more closely. 

Unicast 
As the name infers, Unicast involves traffic going from one host to another. A copy of every packet goes to every host 
that requests it. Unicast is easy to implement as it uses well established IP protocols, however it becomes extremely 
inefficient when many to many communication is required. Since a copy of every packet must be sent to every host 
requesting access to the data this type of transmission is inefficient in terms of both network and server resources and 
presents fairly obvious scalability issues.  

Nevertheless as far as the system deployment issue is concerned, in some particular cases the Unicast technique can 
offer pretty much flexibility, allowing you for instance to start a deployment session immediately from the client side, 
thus bypassing the central console management. 

 

Broadcast 
Broadcast seems to be a solution, but it's not certainly the solution. If you want all the hosts in your LAN be deployed, 
you may use broadcast. Broadcast provides the possibility for one host, typically a server, to send to all receivers on a 
subnet. Packets will be sent only once and every host will receive them as they are sent to the broadcast address. The 
problem arises when perhaps only particular hosts and not all are to receive those packets. Broadcast packets must be 
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processed, regardless of whether or not some certain hosts are interested in the broadcast. Thus, all hosts on that 
subnet will see increased CPU usage, which is not efficient for hosts not participating in the broadcast. 

 

Multicast 
Developed back in the 1980s, multicast is an efficient transmission scheme for supporting group communication in 
networks. The concept of a group is crucial to multicasting. Every multicast requires a multicast group; the sender (or 
source) transmits to the group address, and only members of the group can receive the multicast data. A group is 
defined by a Class D address in the address space 224.0.0.0-239.255.255.255. Contrasted with unicast, where multiple 
point-to-point connections must be used to support communications among a group of users, multicast is more efficient 
because each data packet is replicated in the network - at the branching points leading to distinguished destinations, 
thus reducing the transmission load on the data sources and traffic load on the network links. 

 

To sum up, it should be mentioned that the multicast technology is the most suitable for the system deployment, since, 
instead of sending thousands of copies of backup images, the server streams a single flow that is then directed by 
routers on the network to the target computers that have indicated that they want to receive the data. This eliminates 
the need to send redundant traffic over the network and also tends to eliminate CPU load on systems that are not using 
the multicast stream, yielding significant enhancements to efficiency for both server and network. 
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Paragon Multicast Architecture 

 

Explanation: 

• There can be several Administrator Consoles 

• The Administrator Console sends instructions (create/delete/start/stop/close… deployment session parameters, 
receive logs) to the Infrastructure Server and enables to manage and monitor the deployment procedure 

• The Infrastructure Server initiates and controls the deployment procedure 

• Master images (backup archives) can be placed separately (on a File Server) from the Infrastructure Server 

• PXE Server – a PC with the DHCP and TFTP servers; Images from the PXE server are WinPE or Linux based, and 
prepared by Paragon; Target Module – an object of the deployment procedure. 

 

To optimize the network performance it is strongly recommended to install the 
Infrastructure Server on a File Server where master images are kept. 



15 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

Deployment Console Functionality 
This chapter introduces the console functionality to you. The Deployment Console™ offers a user-friendly interface that 
helps to effectively accomplish required operations while minimizing the possibility of making any mistake. Most 
operations are performed through the system of wizards. Buttons and menus are accompanied by easy understandable 
icons. Nevertheless, any problems that might occur while managing the program can be tackled by reading this very 
chapter. 

Interface Overview  
When you start the console, the first component that is displayed is called the Main Window. It enables you to run 
wizards, specify program settings and to visualize the operating environment. 

The Main window can be conditionally subdivided into several sections that differ in their purpose and functionality: 

 

1. Main menu 

2. Tool Bar 

3. Operations Bar 

4. Current Activity Bar 

5. Status Bar  

Some of the panels have similar functionality with a synchronized layout. The program enables you to conceal some of 
the panels to simplify the interface management. 
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Main Menu  
The Main Menu provides access to the entire functionality of the program. The available functions are as listed below: 

MENU ITEM  FUNCTIONALITY  

Sessions    

New Session… Starting the Create New Deployment Session Wizard that assists you to create new sessions 

Modify Session… 
Starting the Edit Deployment Session Wizard that helps to modify parameters of existing 
sessions 

Delete Sessions… This option enables to delete sessions 

Exit  Exit the program 

Templates  

New Template… 
Starting the Create New Deployment Template Wizard that assists you to create new 
templates 

Modify Template… 
Starting the Edit Deployment Template Wizard that helps to modify parameters of existing 
templates 

Delete Template… This option enables to delete templates 

View     

Refresh Refresh the contents of the Operations Bar 

Expand All Show detailed information on sessions 

Collapse All Hide detailed information on sessions 

Status Bar Display the Status bar 

Templates Pane Display the Deployment templates pane 

Active Session Monitor Display the active session(s) monitor 

All Sessions Runs Display all available sessions 

Settings... Edit the general settings of the program 

Help     

Contents Open the program help 
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Manual Open the general manual of the product 

About  Open the dialog with information about the program  

Tool Bar  
The Toolbar provides fast access to the most frequently used operations: 

BUTTON  FUNCTIONALITY  

 Create a new session 

  Delete a session 

 Refresh the contents of the Operations Bar 

 Show detailed information on sessions 

 Hide detailed information on sessions 

 Show/hide the Templates pane 

 Show/hide available sessions 

 Show/hide the active session(s) monitor 

Operations Bar  
The Operations Bar is located in the center of the main window that emphasizes its importance. Depending on the 
defined settings, the Operations Bar may display the Deployment Templates Pane and/or the Sessions Pane. 

Deployment Templates Pane 
The Deployment templates pane enables to manage deployment templates (get information on all available templates, 
create new templates, edit or delete existing ones).  

 

To know more on how to manage deployment templates, please consult the Managing 
templates chapter. 

Sessions Pane 
The Sessions pane provides the possibility to monitor current state of the active session(s) as well as to get an in-depth 
statistics on all sessions ever run. 

• To get access to the active sessions monitor you should click the Active Sessions Monitor link at the left top 
corner of the pane. 
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• To view statistics on sessions you should click the Sessions Runs link at the left top corner of the pane.  

By clicking on the appropriate link you can change, stop or delete the selected session, view log on the session activity 
as well as to erase the session history. Besides the program provides the session filter to easily group sessions according 
to the time of start. 

 
To know more on how to manage sessions, please consult the Managing Sessions chapter. 

Current Activity Bar 
By clicking on the Current Activity link, in the opened window you can see a well informative log of actions carried out 
by the program. 

Status Bar  
This is the bottom part of the main window. The status bar displays menu hints, for each item the cursor points to. 

You can hide (or show) the bar with the appropriate Main menu item: View > Status bar. 

Settings 
The Settings dialog is available from the Main menu: View > Settings. According to the modified parameters it can be 
conditionally divided into several sections. 

General Options 

 

This section enables you to set a name or IP address of the Infrastructure Server used by default. It can be of great use 
when the Infrastructure Server has been migrated to some other location as it saves from reinstalling the Deployment 
Console. 

The Show computer name option enables to display the client’s computer name instead of MAC address where 
possible. 

 
The option will take effect only after the program restart. 

Session Options 

 

Here you can define how much time (in seconds) the program is to wait for clients to deploy. 
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The option will only be valid for newly created sessions. 

Managing Templates 
The Deployment Console provides the possibility to manage deployment templates (create new templates, edit or 
delete existing ones) without accomplishing the deployment procedure. All available templates are listed in the 
Deployment Templates pane. 

Creating new templates 
There are several ways to create a new template: 

• In the Main menu: select Templates > New Template… 

• In the Deployment Templates pane: click the New Template… link. 

• Call the popup menu for the selected template (right click of the mouse button) in the Deployment Templates 
pane and then choose the menu item: New Template… 

 

 

The last two choices are only available when the Deployment Templates pane is active 
(Main menu: View > Templates Pane). 

 
After following one of the above mentioned actions, the Welcome page of the New Deployment Template wizard is 
displayed.  

 

The wizard is so well designed that you simply need to follow its easy step-by-step instructions to carry out the 
operation. Here you set the parameters of the operation defining: 

• Image to deploy. Select the previously created with Paragon Hard Disk Manager image to be deployed.  
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To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

• Template name. After selecting the required image to deploy, the wizard automatically offers an easy to 
understand name containing the archive name itself. It also leaves the possibility to set the name manually. 

• Destination options: target HD and partition. A hard disk number can be used for both HD and partition 
images, while a partition type and number can be applied to partition images only. If not defined, these values 
will be derived from the specified image. 

• Outgoing network interface. Select a network interface from the list to use when deploying the image. 

• Session type. This section enables to switch between three options: 

- Automatic mode, when clients to deploy are automatically assigned after the session is launched; 

- By session ID, when clients to deploy are defined according to the Session ID of the bootable client media (it 
is needed to set the required Session ID); 

- By MAC address, when clients to deploy are defined according to the MAC address (it is needed to choose 
either the desired MAC addresses from available on the network at the moment, or load the previously 
created list). 

In addition, the ConstantCast mode is allowed for any session type. That means targets will be able to join the 
session at any moment during the process. 

• Depending on the choice, the next page of the wizard offers to set: 

- The highest possible number of active targets; 

- A minimum of active targets; 

- Session time limit. 

• Use of Post-Config options. After the deployment procedure is accomplished, it is possible to send additional 
data to the clients. It can be a sysprep file, some script, drivers, etc. Just press the Browse button to search for 
the required configuration file. 

As a result of the operation you receive a newly created template available in the Deployment Templates pane. Once a 
new deployment template is made you can use it to skip all the steps of the deployment procedure. 

Modifying existing templates 
There are several ways to modify an existing template: 

• In the Main menu: select Templates > Modify Template… 

• Call the popup menu for the selected template (right click of the mouse button) in the Deployment Templates 
pane and then choose the menu item: Modify Template… 

 

The last choice is only available when the Deployment Templates pane is active (Main 
menu: View > Templates Pane). 
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After following one of the above mentioned actions, the Welcome page of the Edit Deployment Template wizard is 
displayed. The work algorithm is practically the same as with the New Deployment Template wizard, except you can see 
all the previously set parameters of the selected template to make the necessary modifications. 

As a result of the operation you receive a modified template available in the Deployment Templates pane. 

Deleting templates 
There are several ways to delete a template: 

• In the Main menu: select Templates > Delete Template… 

• Call the popup menu for the selected template (right click of the mouse button) in the Deployment Templates 
pane and then choose the menu item: Delete Template… 

 

The last choice is only available when the Deployment Templates pane is active (Main 
menu: View > Templates Pane). 

 
After following one of the above mentioned actions, you’re offered to confirm deletion of the selected template. 

Managing Sessions 
With the Deployment Console you can easily manage sessions (create new sessions, modify or delete existing ones). 

Creating new sessions 
There are several ways to create a new session: 

• In the Main menu: select Sessions > New Session… 

• In the Toolbar: click the New Session… button. 

After following one of the above mentioned actions, the Welcome page of the New Deployment Session wizard is 
displayed. 
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The wizard is so well designed that you simply need to follow its easy step-by-step instructions to carry out the 
operation. Here you set the parameters of the operation defining: 

• Use of a deployment template. You may use some previously created deployment template to launch a new 
session, thus the wizard will only offer to enter a session name and schedule the operation.  

In case there are no available templates or you’re not willing to use any, the wizard will proceed through all the 
steps. 

• Image to deploy. Select the previously created with Paragon Hard Disk Manager image to be deployed.  

 

To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

• Session name. After selecting the required image to deploy, the wizard automatically offers an easy to 
understand name containing the archive name itself. It also leaves the possibility to set the name manually. 

• Destination options: target HD and partition. A hard disk number can be used for both HD and partition 
images, while a partition type and number can be applied to partition images only. If not defined, these values 
will be derived from the specified image. 

• Outgoing network interface. Select a network interface from the list to use when deploying the image. 

• Session type. This section enables to switch between three options: 

- Automatic mode, when clients to deploy are automatically assigned after the session is launched; 

- By session ID, when clients to deploy are defined according to the Session ID of the bootable client 
media (it is needed to set the required Session ID); 

- By MAC address, when clients to deploy are defined according to the MAC address (it is needed to 
choose either the desired MAC addresses from available on the network at the moment, or load the 
previously created list). 

In addition, the ConstantCast mode is allowed for any session type. That means targets will be able to join the 
session at any moment during the process. 

• Depending on the choice, the next page of the wizard offers to set: 

- The highest possible number of active targets; 

- A minimum of active targets; 

- Session time limit. 

• Use of Post-Config options. After the deployment procedure is accomplished, it is possible to send additional 
data to the clients. It can be a sysprep file, some script, drivers, etc. Just press the Browse button to search for 
the required configuration file. 

• Schedule the operation. The program allows you to automate deployment operations. The utility for this 
purpose is referred to as the embedded Scheduler, which is used to specify the time for the execution. There 
are several available options. Depending on the choice, the scheduler will display a form that allows you to set 
the schedule: 
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- Cyclic. Mark the option to carry out a cyclic deployment procedure, thus one and the same session will 
automatically be repeated until it is stopped by the user. 

 

The option is not available for a session where clients to deploy are defined by MAC 
addresses. 

- Once. Mark the option to define the date and time when the session is to be launched. 

- Daily. Mark the option to define the time when the session is to be launched, a period during which the 
operation will be performed (in days), the date when the operation will be started first and the date after 
which the task will be deleted from the scheduler's waiting list. 

- Weekly. Mark the option to define the time when the session is to be launched, a period during which the 
operation will be performed (in weeks), days of the week, when the operation will be started, the date 
when the operation will be started for the first time and the date when the operation will cease to run. 

- Monthly. Mark the option to define the time when the session is to be launched, a day of a month when the 
operation starts, the date when the operation will be started for the first time and the date when the 
operation will cease to run. 

As a result of the operation you receive a new session that will be run according to the specified parameters. 

 

All steps of the New Deployment Session wizard can be saved in form of a template for 
further use. 

Modifying sessions 
There are several ways to modify a session: 

• In the Main menu: select Sessions > Modify Session… 

• In the Toolbar: click the Modify Session… button. 

• Click the Change session link in the Sessions pane. 

 

The last choice is only available when the Sessions Runs pane is active (Main menu: View > 
Sessions Runs). 

After following one of the above mentioned actions, the Welcome page of the Edit Deployment Session wizard is 
displayed. The work algorithm is practically the same as with the New Deployment Session wizard, except you can see 
all the previously set parameters of the selected session to make the necessary modifications. 

As a result of the operation you receive a modified session. 

Deleting sessions 
There are several ways to delete a session: 

• In the Main menu: select Sessions > Delete Session… 

• In the Toolbar: click the Delete Session… button. 

• Click the Delete session link in the Sessions pane. 
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The last choice is only available when the Sessions Runs pane is active (Main menu: View > 
Sessions Runs). 

 
After following one of the above mentioned actions, you’re offered to confirm deletion of the selected session. 

Post-Config Usage 
After the deployment procedure is accomplished, the program enables to easily customize the client disk layout and set 
up the required Windows settings (PC name, DNS, display, etc.). Especially for that purpose so called Post-Config options 
have been introduced: 

 

To make good use of them you should bear in mind the following issues: 
 

• Options can only be defined through one configuration .ini file of a certain format; 
 

[PostConfig]   // to define a .psl script for the Post-Config 
PSLScript=PostConfigTemplates\FileUpdate\fileupdate.psl 
[FileUpdateList]   // to define files to update 
SysprepINF=PostConfigTemplates\FileUpdate\sysprep.inf 

 

• Options cover a limited range of functionality: 
- Set a Paragon script for execution after deployment; 
- Update files on the client computer after deployment; 
- Modification of .ini files on the client computer after deployment. 

 

The Paragon Deployment package comes with a set of ready-made post-config templates that can be found in the Image 
Storage directory. Most of them are completely automated and require no manual modification, except for 
the AdaptiveRestore, FileUpdate, FileUpdateVista.  

You can find how to configure these templates according to your needs below. 

Adaptive Restore Template 
Adaptive Restore is a special technology that enables to successfully recover Windows 2000/XP/Server 2003 as well as 
Windows Vista/7/Server 2008 to a different hardware configuration. 

Adaptive Restore for Windows 2000/XP/Server 2003 actually implies two operations: 
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• Providing the ability to change the Windows kernel settings to the most suitable for your new configuration. 
The program will automatically add all available Windows HAL and kernels to the boot menu (the boot.ini file) to 
choose the required platform in case your system fails to boot (Uniprocessor, Multiprocessor, or Old legacy PC 
without ACPI). You can later remove them from the menu either under Windows or with Boot Corrector. 

 
If you’ve got a 64-bit operating system, no options will be added to the boot menu. 

• Automatic replacement of the boot critical drivers (HDD controller, PS/2 and USB mouse and keyboard) to the 
default Windows drivers to provide the maximum level of compatibility. Once your Windows starts up, it will 
initiate reconfiguration of all Plug'n'Play devices, so it is recommended to provide the latest drivers for your 
motherboard and processor at this step, as it can considerably improve the overall performance of your system. 

 

The current version of the program does not enable to add any 3rd party driver during the 
operation, which may lead to boot problems (relevant for SCSI and Serial ATA controllers 
mostly). In some cases however you can tackle the problem by switching the required 
device to the standard ATA compatible mode in BIOS (e.g. the Intel ICH8 controller can be 
set in the IDE mode, not AHCI). Moreover if you’re going to upgrade your motherboard to 
one of the same manufacturer, just update the driver before the operation to guarantee 
successful startup of your system later. 

Adaptive Restore for Windows Vista/7/Server 2008 is based on the fact that these operating systems do not delete their 
distributive driver repositories after the setup, but simply make them inactive in the Windows Registry. So thanks to 
Adaptive Restore technology these driver repositories can be made available during the restore procedure to let 
Windows Vista or 2008 Server automatically find and install any lacking driver with no action from your side required, 
what is very convenient. 

However you might face a situation when no driver has been found in the driver repository. In this case you will have to 
provide an exact location of the required drivers. With a large amount of client computers it may be difficult to insert 
Windows distributive CD/DVD every time it is required. To make an operating system install extra drivers automatically, 
just copy them to a shared folder on the network. After you specify a path to a remote driver repository in the 
ad_restore.psl script, all drivers will be copied to a pre-defined folder on a target PC, and the system registry will be 
modified to automatically search for drivers in a specified folder. 

To set all necessary parameters, open the ad_restore.psl script with a text editor.  The first part of the script will look 
like this: 

 

• Make sure that the <disk_n> and <sys_part> values match the HDD and system partition numbers on a 
destination PC. 

• Specify a path to the remote driver repository.  Keep in mind that the <win_src_path> parameter is used for a 
WinPE and <lin_scr_path> - for a Linux deployment client. The path should point to a folder, mounted on the 
target PC. So if the drivers are kept in the \\server\mcast\drv folder, and \\server\mcast is to be mounted, 
define win_src_path=”\drv” 
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This script cannot mount a shared folder. You should either set mount parameters when 
creating a bootable image for the target PC or mount a shared folder manually before the 
session starts. Anyway the mount point should be “/mnt/net0” for a Linux and “Z:\” for a 
WinPE client. 

• Specify a folder where to copy drivers on the target PC. The path must point to the system partition. So if you 
define win_dst_path=”\drivers”, the drivers will be copied to C:\drivers. 

• Save and close the script. Now it is ready to use. 

FileUpdate Template 
FileUpdate is closely connected with the Sysprep utility. The Microsoft Sysprep is a handy tool specially designed for 
system administrators, OEM (Original Equipment Manufacturers) System Builders, etc. to automatically deploy Windows 
based operating systems on multiple computers. With Sysprep you can easily remove all the unique information from a 
Master PC (used as a sample computer) in order to make it ready to deploy its image to other computers of different 
hardware configuration. Besides it enables to automatically set up additional configuration options (workgroup, domain, 
organization name, PC name, default display size, etc.). 

For Windows XP all the Sysprep configuration information is kept in one simple .inf file. 

 

To know more about the Microsoft Sysprep functionality, please consult documentation 
that comes with the utility. 

Depending on a computer MAC address, the FileUpdate template enables to set up different configuration options (e.g. 
PC name) automatically after the deployment is over. 

 

Since Windows Vista there has been used a different format of the answer file, so please 
use the FileUpdateVista template for these operating systems. 

To deploy a system with the FileUpdate option, you need to accomplish the following steps: 

• Run sysprep.exe on a master PC with a pre-installed operating system. 

• Create a disk or partition image with Hard Disk Manager. 

• Prepare the Sysprep answer file. It’s a text file that scripts answers to a series of the GUI dialog boxes. To create 
it, please use a text editor or the Windows Setup Manager tool. The easiest way however is to modify the 
Sysprep.inf file that comes with our template (<ImageStorage>\PostConfigTemplates\FileUpdate\). You’re to 
specify there all common configuration options like TimeZone or Workgroup. 

• Edit the FileUpdate.ini file that comes with our template. For each PC to configure after the deployment, there 
should be created a section describing specific parameters like ComputerName. An example is already included 
in our template: 

;update [UserData] section on PC 1 
;you are to set the correct MAC address!!! 
[00-0A-48-00-DD-1A.SysprepInf.UserData] 
FullName="Client1” 
OrgName="Company1" 
ComputerName="Computer1" 
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You can add/remove any configuration option you’d like to set up after the deployment. 
You should also modify the default path ufsd://HARD0/PARTITION0/sysprep/sysprep.inf if the system partition 
is supposed to restore not to HDD 0, partition 0. 

• Create a new deployment session using the prepared image and the FileUpdate.ini file for post-config. 

FileUpdateVista Template 
FileUpdateVista has much in common with FileUpdate, except for one thing – you cannot set different configuration 
options for different computes in one and the same session.  

To deploy a system with the FileUpdateVista option, you need to accomplish the following steps: 

• Run sysprep.exe on a master PC with a pre-installed operating system (Windows Vista or later versions). 

• Create a disk or partition image with Hard Disk Manager. 

• Prepare the Sysprep answer file with Windows System Image Manager. You can also modify the Unattend.xml 
file that comes with our template (<ImageStorage>\PostConfigTemplates\FileUpdateVista\). You’re to specify 
there all common configuration options like ProductKey or Workgroup. 

• Edit the FileUpdate.ini file that comes with our template, if the system partition is supposed to restore not to 
HDD 0, partition 0. Please make sure the correct destination path is specified in the following section: 

;destination to update unattend.xml 
[XMLUpdate] 
Destination = 
ufsd://HARD0/PARTITION0/Windows/Panther/unattend.xml 
 

 

• Create a new deployment session using the prepared image and the VistaUpdate.ini file for post-config. 
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Target Related Functionality 
This chapter introduces the target module functionality to you. As it was already mentioned in the previous chapters, 
the main purpose of the Target Module is to get client computers ready for deployment. It can be initiated either with 
the help of the bootable media or the PXE facilities. Actually it is a Linux SuSe based program, which offers a Windows 
XP like environment.  

 

In our latest version we offer WinPE based bootable media as well. It won’t be illustrated 
separately, for the functionality and interface of both is quite the same. 

After the client computer has been booted you can see a convenient startup menu with the list of available operations 
on the left and a short description of the selected item on the right: 

 

• Server-driving mode to initiate the deployment client and join an existing session 

• Client-driving mode to launch the deployment wizard and specify operation parameters 

• Network Configurator to work with shared resources of the LAN (e.g. copy files or backup images to recover a 
corrupted system) 

• Hard Disk Manager to create/restore backup images or carry out partitioning operations, etc. (to know more 
about the program, please consult documentation that comes with it) 

• Simple Restore Wizard to easily get the system back on track 

• Log Saver to tackle problems with handling the program by compressing logs to send to the Paragon Support 
Team 

 

The startup menu contents of the bootable media can be customized.  

By default the client computer will be automatically initiated after a 10 second idle period. 
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Server-driving mode 
 After launching the Server-driving mode you can see a well informative statistics window where it is possible to monitor 
real-time all operations executed at the moment. 

 

In this mode the client will automatically join a session depending on parameters of the used target boot media. If no 
session ID was specified during the boot media creation, the client will join any existing automatic-mode session. 
Otherwise it will join a session with the same session ID. 

Client-driving mode 
After launching the Client-driving mode you will need to specify the following deployment parameters: 

 

• Infrastructure Server. The server can be defined either by name or IP address. 



30 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

• Deployment Source. Depending on the chosen option different algorithms of joining/creating a session will be 
used: 

- Connect to the current session. Set a session ID or browse for an appropriate session if you want to join a 
session that has already been started. Please note, if you enter a session ID manually and no session with 
this ID is found, the deployment client will stay idle until you cancel it or create an appropriate session from 
the Deployment Console. 

- Define image for the deployment. Select the option if you want to create a new session or need to specify 
the destination HDD and partition for deployment. 

 

If you set the same image name and destination parameters for more than one target 
module, the same session will be used for deployment. 

Mark the Show the additional page… option if you need to specify the destination HDD and partition, then 
press Next.  

 

 - Destination hard disk. Specify where to deploy a backup image of a separate partition/single hard disk. Please 
note, this parameter will not be taken into account if the backup image contains two or more hard disks. 

- Destination partition. You can choose a partition number and type, if a image of a single partition is deployed. 
Please note, this parameter will not be taken into account if the backup image contains two or more partitions. 

Click Start Session to initiate the deployment procedure and open the statistics window to monitor real-time all 
operations executed at the moment. 

 

With the Boot Media Builder you can set the mentioned above parameters at the point of 
creating bootable media thus saving yourself from the need of doing it every time the 
client-driving mode is launched. 

Boot Media Builder 
The Boot Media Builder is a component of the Paragon Deployment package that provides the possibility to build 
bootable media to get a client computer ready for the deployment procedure. 
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Starting  
To start the Boot Media Builder you need to launch it from the application's program group of the Start Menu. By 
default, it will be: 

Start > Programs > Paragon Deployment Manager > Boot Media Builder 

Then the Welcome page of the wizard is displayed. 

Boot media options  
The Boot Media Builder allows creating bootable media based on one of the following options: 

 

• Create a new boot media configuration. It enables to change any of the default parameters during the boot 
media creation. 

• Load an existing boot media configuration. It allows you to use the previously created configuration (you can 
see all the previously set parameters to make the necessary modifications). 

• Use a custom CD/DVD image. It enables to choose a previously created .ISO file and burn it to CD/DVD. Besides, 
you can add additional files to that image. 

• Use a custom .wim image (for WinPE). It allows you to choose a previously created .wim image and make any 
type of bootable media out of it. However there is no possibility to modify the boot media parameters. 

• Use a custom folder as source for the .wim image (for WinPE). A custom directory can serve as source for 
bootable media. In this case however all configuration files should be edited manually beforehand. 

Environment for the boot media 
In case the environment type is not obvious, or a path to the OPK/WAIK tools is needed, the following page will be 
displayed: 
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On this page you can choose either to create a Linux or WinPE based bootable media. 

The functionality of both boot media is quite the same except for one thing – you cannot add additional drivers to 
WinPE, neither during its creation nor after the target PC startup. The WinPE environment however can be useful in 
some specific cases like deployment of .wim images with the Microsoft ImageX utility, etc. 

 

You need either Windows Automated Installation Kit (WAIK) or OEM Preinstallation Kit 
(OPK) to create a WinPE bootable media. Due to the license stipulations, Paragon has no 
rights to distribute Microsoft software. That’s why you need to get the required tools 
yourself. 

Menu customization  
The program allows you to define the menu contents and some more additional parameters that will be taken into 
account during the boot media startup: 
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By marking/unmarking a checkbox opposite the required menu item you can choose whether that particular component 
will be available or not. 

 
Shadowed items of the menu are not allowed to customize. 

Besides it is possible to create a new item(s) by pressing the Add button in the right corner of the dialog. This feature 
can be of great use since it enables to set any custom script for execution. To assign a script to a newly created menu 
item press the Browse… button and choose the required script. 

Moreover you can choose what component of the menu will be automatically selected on the expiry of a certain time 
limit. 

Network properties  
On this page you can choose parameters of the network connection: 
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• Automatically after booting. This option is particularly beneficial for manufacturing purposes, since it allows 
automating the deployment procedure. To make it work you’re to set the following additional parameters: 

- Network adapter to use to select an order number of the required network adapter. 

- IP address settings to choose whether to get an IP address automatically from the DHCP Server or set it 
manually, thus bypassing the DHCP Server capabilities. 

• Manually after booting. This option allows you to connect to the network manually after the client computer 
has been started up. 

• No network support. This option can be selected only if neither Server-driving mode nor Client-driving mode 
was enabled. In this case there will be no deployment procedure available. 

Network mount options  
If an automatic connection to the network has been chosen, the Boot Media Builder enables to set the following mount 
options: 
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If a shared folder has been specified, it will be mounted at the target PC startup. With no pre-defined username it will 
be mounted under the Guest account. 

 

You should use back slashes for WinPE, like \\server\share, while for Linux – forward 
slashes, like //server/share. 

Server-driving mode options  
To deploy in the server-driving mode, set the following additional parameters: 

 

• Session ID to assign certain clients to the required deployment session by using the Session ID identifier. 
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• Hard disk to use to choose where to deploy a backup image of a separate partition/single hard disk. 

• Clear hard disk before the deployment procedure to make sure there is no data on it, thus avoiding any possible 
troubles. 

• Hide partitions after the deployment procedure. 

• Check file system integrity after the deployment procedure to detect possible file system errors. 

• Paragon script to execute before the deployment procedure to automatically accomplish, for instance, some 
partitioning tasks, etc. on the client computer.  

Client-driving mode options  
To deploy in the client-driving mode, set the following additional parameters: 

 

• Infrastructure server. You should set a name or IP address of the required Infrastructure Server. 

 

In case the Infrastructure server has not been set in this section, the program will 
automatically offer to do it after the Deployment wizard is launched. 

• Image to deploy. Set a path to the previously created with Paragon Hard Disk Manager image. 

 

In case the image has not been specified in this section, the program will automatically 
offer to do it after the Deployment wizard is launched. 

Hard disk to use. You can choose where to deploy a backup image of a separate partition/single hard disk. This 
parameter will not be taken into account if a backup image contains more than one hard disk. 

Additional drivers  
You can inject additional drivers to WinPE media during its creation: 
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Click the Add button to specify the required driver, then set a path to the required .inf file (you can either browse for it 
or enter it manually). Please note, only .sys drivers are allowed to inject. 

CD/DVD label and extra files 
You can set a label and also add/delete additional files to the root of the bootable media just by pressing the 
appropriate buttons. The resulted list of files can be saved for future use. 

Saving boot media configuration  
The wizard enables to save the current boot media configuration for future use: 
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You can either select an existing configuration or create a new one by pressing the appropriate button at the right of the 
configuration list. 

Destination parameters 
The wizard enables to choose whether to burn the resulted bootable image to a CD/DVD/Blu-ray disc or save it as an 
image of the following types: 

A .wim image (available for WinPE only); 

An .iso image (available for both, WinPE and Linux); 

A PXE Server image. 

 

CD/DVD writing parameters 
Writing parameters include writing speed (maximum or minimum) and the ability of ejecting the recorded disc after 
completing the operation. 

If the inserted disc is not empty, the wizard suggests you erasing its contents. When you confirm the operation, the 
program deletes the re-writable disc's contents and starts the recording process. 

Results  
The Boot Media Builder starts the operation after completing the settings mentioned above. As a result, you receive the 
required bootable media. 

Default boot media configurations 
The Paragon Deployment package comes with the following ready-made configurations: 

• Simple Restore Configuration enables to restore an image directly from the boot media (no network support is 
required). To create an appropriate boot media, please do the following: 

- Select the Load existing configuration option on the first page of the wizard 

- Choose Simple Restore Configuration from the list 
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- When offered to add extra files, select the previously created with Hard Disk Manager image to deploy. 

At the target PC startup you will be prompted to launch the deployment process. After the confirmation the 
previously added image will be restored to hard disk 0. 

• WIM Deploy Configuration enables to create a .wim image of the system partition using the Microsoft ImageX 
utility or deploy the previously created .wim image to several computes simultaneously. To create an 
appropriate boot media, please do the following: 

- Select the Load existing configuration option on the first page of the wizard 

- Choose WIM Deploy Configuration from the list 

- If you need to create an image of the system partition, edit the network mount options. The image will be 
placed to a specified shared folder 

- If you need to deploy a previously created .wim image, edit the deployment.cfg file (by default, it is placed 
in the C:\Program Files\Paragon Software\Deployment Manager\Boot Media 
Builder\WinPE\winpe_custom\DMClientAPI folder). Set a deployment server name or IP address, as well 
as an image to deploy. Do not modify the other parameters. The resulted file should look like this: 

deployment_server=10.0.0.1 
deployment_image=test_image.wim 
deployment_silent=on 
deployment_target_file=Y:\test.wim 
deployment_dynamic=on 
deployment_nographic=on  

 
- When offered to add extra files, select the ImageX utility from the OPK/WAIK tools folder (e.g. C:\Program 

Files\Windows OPK\Tools\x86\imagex.exe).  
 
At the target PC startup you will be able either to create or deploy image. 

Paragon PXE Server 
The Paragon PXE Server is a component of the Paragon Deployment  package that enables to remotely boot a computer 
with no operating system installed. This procedure implies that a networked client PC is able to enter a network, acquire 
a network address from the DHCP server and subsequently download from the TFTP server a NBP (Network Bootstrap 
Program) to set itself up, thus saving from the need of bootable media. 

 Paragon PXE Server works as a service in the system. To make the process of its configuration and management easy 
and understandable there is a convenient dialog. It can be launched from the application’s program group of the Start 
Menu. By default, it will be: 

Start > Programs > Paragon Deployment Manager > PXE Server > PXE Server Settings 

Depending on whether you decided to use the Paragon’s DHCP server or not (defined during the installation) the dialog 
enables to set the following parameters: 
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• Start IP address 

• Number of available IP addresses 

• Subnet Mask 

 

• A PXE image used to remotely boot the client computers 

You can start/stop Paragon PXE Server by clicking the appropriate button. Please note, if you click the Apply button 
when the service is active, it will lead to its restart with new parameters. 

By clicking the Advanced Settings button you can modify a number of additional parameters as well as see some 
operation statistics. 

 

Client computers must have PXE support in order to use the PXE Server. 

To know more about PXE Server, please consult the Glossary. 

Configuring DHCP Server for Deployment Purposes by the Example of Windows Server 2003 
To set up the DHCP Server for the deployment purposes, please do the following: 

1. Run the DHCP management console. There are several ways to do that: 

- Select Start > Run…, then execute the "DHCPMGMT.MSC /S" command; 

- Start > Settings > Control Panel > Administrative tools > DHCP. 
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The DHCP management console will be launched: 

 

2. Set up your DHCP server correctly. Windows Server 2003 provides a bunch of services and settings for the 
DHCP service. You are to set up the global settings of the DHCP server: 

 

There are two DHCP options that need customization that is Option 066 - Boot Server Host Name and Option 
067 - Bootfile Name. 

- Select the Server Options item in the DHCP management console and click the Server Options item; 

- In the Server Options dialog, click the Advanced tab; 

- Select the DHCP Standard Options vendor class; 

- Select the Default BOOTP Class user class; 



42 

Copyright© 1994-2010 Paragon Software Group. All rights reserved. 

- Find the Option 066 named Boot Server Host Name: 

 

- Mark the Option 066; 

- Enter an IP address or a network name of a TFTP server that is used for dispatching PXE bootable images. 

 

In case the TFTP and DHCP servers run on the same computer, enter the computer network 
name or its IP address as it seen from the other computer of your LAN. 

Do not use the Localhost alias or its IP equivalent 127.0.0.1. 

- Find the Option 067 named Bootfile Name: 
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- Mark the Option 067; 
- Specify a relative path to a bootable image and its file name to boot remote computers from. 
 

 
The specified path should exist and be configured on the TFTP server. 
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Infrastructure Server Functionality 
The Paragon Infrastructure Server is a component of the Paragon Deployment package that provides all facilities needed 
to initiate and control the deployment procedure. It works as a service in the system and is partially set up during 
the installation.  

However a thorough setup can only be accomplished through its configuration file. By default, you can find it here: 

C:\ProgramData\mcsrv\config\coord.cfg (or C:\Documents and Settings\All Users\Application 
Data\mcsrv\config\coord.cfg for Windows XP/Server 2003 and earlier versions) 

[ServerSettings] 

PACKINTERVAL=2 

PACKTIME=1:00:00 

IMAGEBOOT=C:\ImageStorage\ 

 

• PACKINTERVAL. The program keeps gathering data on the carried out deployment operations and places it in a 
special database. As time goes by the database starts containing plenty of outdated information, thus 
considerably increasing in size. To avoid it, you can choose how often it should be compressed by entering the 
required period of time in days 

 
In case the interval is not set, the database will be compressed daily. 

• PACKTIME to set the exact time (in the HH:MM:SS format) of the database compression 

 

In case the time is not set or some impossible value is used, the database will not be 
compressed at all. 

• IMAGEBOOT to define default location of backup images 

• LOGPATH to set where to place logs of the Infrastructure Server. 

 
In case it is not set, the program will use the Infrastructure Server directory. 

You can also change the transfer parameters by editing mcast.ini file (if not created earlier it should be placed near 
coord.cfg): 

• BASEID to define the offset from the multicast base IP address (224.1.1.1). The default value is 1, available 
range: 1…224 

• TCP_ANSWER_TIMEOUT to set TCP request latency in milliseconds. The default value is 10000, available range: 
1000…10000 

• TRAFFIC_TIMEOUT to define an interval between packet transmissions (in milliseconds). It can help to decrease 
the traffic load on the network. The default value is 0, available range: 0…5000 
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• MULTICAST_TTL to define the maximum number of routers between the server and targets minus 1.The default 
value is 1; available range: 1…255 

• ENABLE_FLOW_CTRL to allow the packet transfer rate control. The default value is 1, available values: 0 
(disabled), 1 (enabled) 

• SET_SMALL_BUFFER to allow the smallest packet size. Smaller data blocks decrease the transfer rate but 
increase its reliability. The default value is 0, available values: 0 (disabled), 1 (enabled). 

 
Please use small buffer size when deploying in a virtual environment like VMware. 

• WAKEUP_COUNT to define a number of computers that can be turned on through Wake-on-LAN at a time. The 
default value is 4, available range: 1…50 

• WAKEUP_TIMEOUT to define an interval between computer groups to be turned on through Wake-on-LAN (in 
seconds). The default value is 10, available range: 1…120 
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License Control 
Especially for evaluation purposes, you’ve got the option to try Paragon Deployment Manager under the terms of our 
evaluation license. It enables to use the product for 60 days and deploy no more than 100 machines (however each unit 
can be deployed unrestrictedly during the trial period). 

On purchasing the product you will be provided with a commercial license with no time limit and a new total license 
quota depending on your needs. 

To add a new license, please do the following: 

• Open the Deployment Console; 

• Select Help > About in the main menu; 

• In the opened dialog press Add License and select a new license file. 

 

After confirmation, the new license will be passed over to the Infrastructure Server. 

 

Replacing the evaluation license file with a commercial one will set the Total License Quota 
equal to the commercial license quota. Adding one more commercial license however, will 
make the total quota be increased correspondingly. 

You can always learn about the Total/Expended/Available License Quota in the About 
dialog. 
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Typical Scenarios of System Deployment 
This chapter lists various scenarios of the system deployment that may be accomplished with Paragon Deployment 
Manager. You can find here useful recommendations and descriptions of operations. 

Automatic Cyclic Deployment with PXE Environment 
This scenario is an ideal solution when you have to deal with the problem of deploying a bunch of identical computers 
on a regular basis in the automatic mode. The program provides the possibility to start up clients by using the PXE 
facilities and then deploy them automatically. 

To launch the operation you should take the following steps: 

1. Set up a Windows based Master computer by using the Microsoft Sysprep utility; 

2. Create a Master image with Paragon Hard Disk Manager; 

 

To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

3. Install the Deployment Console and the Paragon PXE Server; 

4. Launch the New Deployment Session wizard of the Deployment console and set it up to deploy automatically. 
You should define: 

- The session name 

- The image file to deploy 

- Number of clients to deploy 

- Allowable number of clients to successfully deploy in order to finish the session (set value or percentage) 

- The time limit by exceeding which the lagging behind clients may be excluded from the session 

- Post-Config options (the sysprep.inf file may be updated without rebuilding the master image) 

- Cyclic type in the scheduler providing one and the same session to be automatically repeated after 
connecting new clients. Thus there is no need to launch the session manually each time new clients are 
connected 

5. Connect computers and launch them from the Network; 

6. The deployment procedure will be automatically launched. 

Automatic Cyclic Deployment with Bootable Media without Session ID Key 
There can be situations when the PXE facilities are not that preferable to deploy PCs or available network cards have no 
support of booting from the LAN. In this case you can employ this very scenario. It is practically the same as the previous 
one. The only difference is that for launching the client module is used bootable media instead of the PXE environment. 
The Session ID is not taken into account here since computers are identical and there is no need to identify various 
deployment sessions, otherwise please consult the Automatic Cyclic Deployment with Bootable Media with Session ID 
Key chapter for more information. 
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Automatic Multisession Cyclic Deployment with Bootable Media with Session ID Key 
To deploy several computers of different hardware at the same time it is required to use different Master images hence 
different sessions. Each session provides its own ID and certain target computers are booted from the bootable media 
containing particular ID. Thus clients are assigned automatically after checking the Session ID. 

To launch the operation you should take the following steps: 

1. Set up Windows based Master computers for each particular computer(s) by using the Microsoft Sysprep utility; 

2. Create Master images with Paragon Hard Disk Manager; 

 

To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

3. Install the Deployment Console; 

4. Prepare bootable media with different Session ID for each particular computer(s); 

5. Create templates of the deployment sessions for each particular computer(s). You should define: 

- The session name 

- The Session ID 

- The image file to deploy 

- Number of clients to deploy 

- Allowable number of clients to successfully deploy in order to finish the session (set value or percentage) 

- The time limit by exceeding which the lagging behind clients may be excluded from the session 

- Post-Config options (the sysprep.inf file may be updated without rebuilding the master image) 

- Cyclic type in the scheduler providing one and the same session is automatically repeated after connecting 
new clients. Thus there is no need to launch the session manually each time new clients are connected 

6. Boot computers from the required bootable media to automatically launch the deployment procedure. 

Deployment with MAC Address as an Identifier for a Particular Session 
(Machines are booted either from network or bootable media) 

It is a common practice for big companies when system administrators have to deal with restoring particular computers 
on a regular basis. In this case the deployment procedure can be launched manually or scheduled. If a list of the 
required MAC addresses is available, it is possible to use just one PXE Server for computers of different hardware in that 
way saving from creation of different bootable media for each particular computer. To boot from the LAN the Wake-up 
on LAN feature can be used. 

To launch the operation you should take the following steps: 

1. Set up Windows based Master computers for each particular computer(s) by using the Microsoft Sysprep utility; 

2. Create Master images with Paragon Hard Disk Manager; 
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To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

3. Install the Deployment Console; 

4. Prepare bootable media with different Session ID for each particular computer(s) or install the Paragon PXE 
server; 

5. Create templates of the deployment sessions for each particular computer(s). You should define: 

- The session name 

- Computers to deploy. Either import of a list of MAC addresses or manual selection from the active targets is 
required 

- The image file to deploy 

- Number of clients to deploy 

- Allowable number of clients to successfully deploy in order to finish the session (set value or percentage) 

- The time limit by exceeding which the lagging behind clients may be excluded from the session 

- Post-Config options (the sysprep.inf file may be updated without rebuilding the master image) 

6. Boot computers from the LAN or the required bootable media. PCs can be automatically rebooted from the 
Windows in case additional Windows agents are installed. Wake-up on LAN feature can also be used. 

7. Schedule the operation or launch it manually. 

Classical Client-Driving Deployment without Central Control when Client Initiates the 
Deployment 
(The client is started either from the bootable media or through the PXE environment) 

To get maximum flexibility the program provides the possibility to initiate deployment sessions from the client’s side, 
thus bypassing the central console management. At first sight this particular scenario might look like a simple restore 
procedure from the network-shared folder. But that is not exactly so. In this case the client does not access images 
directly but with the help of the Infrastructure Server facilities. 

To launch the operation you should take the following steps: 

1. Install the Infrastructure Server and configure it properly (during the installation procedure or by using 
its configuration file) to use a specific directory as an Archive Storage; 

2. Create a Master image with Paragon Hard Disk Manager and place it into the Archive Storage; 

 

To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

3. Launch the client computer by using the Paragon PXE Server or create a bootable CD/DVD with the Boot Media 
Builder to do it; 

4. Start the deployment wizard; 
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5. Define the required Infrastructure Server and image to deploy; 

 

With the Boot Media Builder you can set the mentioned above parameters at the point of 
creating bootable media thus saving yourself from the need of doing it every time the 
client-driving mode is launched. 

6. Click the Finish button to initiate the deployment procedure and launch the statistics window where it is 
possible to monitor real-time all operations executed at the moment. 

 

If you set the same image name and destination parameters for more than one target 
module, the same session will be used for deployment. 

Direct Deployment with Bootable Media but no Network Support 
There can be situations when it is required to deploy the client computer(s) but no network support is available at the 
moment. Just to tackle problems of that kind the Boot Media Builder contains the Simple Restore configuration to 
deploy directly from the bootable media. 

To launch the operation you should take the following steps: 

1. Install the Boot Media Builder; 

2. Create a Master image with Paragon Hard Disk Manager; 

 

To know more about Paragon Hard Disk Manager functionality, please consult the 
program’s help. 

3. Launch the Boot Media Builder and select Load an existing boot media configuration; 

4. Press the Browse button and find the SimpleRestoreConfiguration folder (by default, 
C:\ImageStorage\SimpleRestoreConfiguration); 

5. On the Additional Files page of the wizard select the previously made Master image to add to the bootable 
media; 

6. Burn the resulted bootable media to CD/DVD; 

7. Boot the client computer from the bootable media to initiate deployment. 
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Glossary 

Unicast 
Unicast is the term used to describe communication where a piece of information is sent from one point to another 
point. In this case there is just one sender, and one receiver. 

Unicast transmission, in which a packet is sent from a single source to a specified destination, is still the predominant 
form of transmission on LANs and within the Internet. All LANs (e.g. Ethernet) and IP networks support the unicast 
transfer mode, and most users are familiar with the standard unicast applications (e.g. http, smtp, ftp and telnet), which 
employ the TCP transport protocol. 

Multicast 
Multicast is the delivery of information to a group of destinations simultaneously using the most efficient strategy to 
deliver the messages over each link of the network only once and only create copies when the links to the destinations 
split. 

The word "Multicast" is typically used to refer to IP Multicast, the implementation of the multicast concept on the IP 
routing level, where routers create optimal spanning tree distribution paths for datagrams sent to a multicast 
destination address in realtime. But there are also other implementations of the multicast distribution strategy such as 
system deployment, etc. 

Broadcast 
In computer networking, broadcasting refers to transmitting a packet that will be received (conceptionally) by every 
device on the network. In practice, the scope of the broadcast is limited to a broadcast domain.  

Broadcast transmission is supported on most LANs (e.g. Ethernet), and may be used to send the same message to all 
computers on the LAN (e.g. the address resolution protocol (arp) uses this to send an address resolution query to all 
computers on a LAN). Network layer protocols (such as IP) also support a form of broadcast which allows the same 
packet to be sent to every system in a logical network. 

PXE (Preboot Execution Environment) 
The advent of the Preboot Execution Environment PXE) has provided Altiris with the mechanism to rationalise the cost 
of installing a new operating system down to an acceptable level. It has enabled the use of Rapid Deploy (a component 
part of the Altiris eXpress Server which is used to remotely deploy images) over the network by allowing a computer, 
which has no working operating system to remotely boot from the network without any manual intervention at the 
machine by an engineer or user. 

In short, by employing the abilities referred to above, a client PC should be able to enter a network, acquire a network 
address from the DHCP server and subsequently download a NBP (Network Bootstrap Program) to set itself up. 

UDP compared to TCP 
TCP cannot be used effectively for multicasting since the TCP protocol is designed for reliable communications between 
two end points, not between a group of client computers and a server. There are no multicasting protocols that use TCP. 
UDP is fast and enables to stream the data: That is, it is not required to wait for an acknowledgment before sending the 
next packet. 

Sysprep (System Preparation) 
The Microsoft Sysprep is a handy tool specially designed for system administrators, OEM (Original Equipment 
Manufacturers) System Builders, etc. to automatically deploy Windows based operating systems on multiple computers. 
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With Sysprep you can easily remove all the unique information from a Master PC (used as a sample computer) in order 
to make it ready to deploy its image to many other computers of different hardware configuration. Besides it enables to 
automatically set up additional configuration options (workgroup, domain, organization name, PC name, default display 
size, etc.). 

All the Sysprep configuration information is kept in one simple .inf file.  

 

To know more about Microsoft Sysprep functionality, please consult documentation that 
comes with the utility. 

Wake-up on LAN 
Wake-up on LAN is a technology that enables a network administrator to remotely power on a computer or to wake it 
up from the sleep mode, thus saving from the need to physically visit each computer on the network. Wake-up on LAN 
works by sending a wake-up frame or packet to a client machine from a server machine that has remote network 
management software installed. The Wake-up on LAN network adapter installed in the client receives the wake-up 
frame and turns on. The scheduled tasks then begin. 

 

To use Wake-up on LAN you need a network adapter, motherboard, and remote 
management software compatible with that technology. 

ISO File 
An ISO file contains the complete image of a CD/DVD disc in the ISO 9660 file system. That means that besides data files 
it includes all the file system metadata (bootstrap code and attributes). These properties make it an attractive 
alternative to physical media for the distribution of software over the Internet. 

DHCP Server 
DHCP (Dynamic Host Configuration Protocol) is a protocol for assigning dynamic IP addresses to devices on a network. 
With dynamic addressing, a device can have a different IP address every time it connects to the network. In some 
systems, the device's IP address can even change while it is still connected. DHCP also supports a mix of static and 
dynamic IP addresses. 

TFTP Server 
TFTP (Trivial File Transfer Protocol) is a simple form of the FTP (File Transfer Protocol). TFTP uses the User Datagram 
Protocol (UDP) and provides no security features. It is often used by servers to boot diskless workstations, X-terminals 
and routers. 
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